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Madam (Microarray Data Manager, version 4.0) is a suite of tools used to upload, 
download, and display a plethora of microarray data to and from a database management 
system (MySql).  Working as an interface for the MySql, Madam allows scientists and 
researchers to manage their microarray data efficiently to meet the requirement of 
experiment annotation and data mining.  

The database working as a repository was designed and guided by MIAME.  This version of 
MADAM allows users to export the data in MAGE-ML format if the data are uploaded into the 
database.  

If you have any questions about this software and need technical support, please contact 
madam@tigr.org for the help.  We appreciate your comments. 

Platform / System Requirements 
Java Runtime Environment (JRE) 1.3 or later 
Java Virtual Machine 1.3 or later 
Platform: Windows/95/98/2000/XP/NT 
Hard disk: more then 2 GB. 
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1. Installation 
 

Notice: You must have administrative privilege for your system to install Madam. 
 
Because MySql, a product of open source project for Database Management System 
(DBMS), is used as a back end for data storage, it must be installed and configured on 
your system before you operate the Madam.  The configuration involves creating 
databases, setting up user privileges, and making communication protocol with Madam.  
This is a complicate task.  However, we have developed an installer to complete the task 
smoothly for you. 
 
The installation is straightforward and involves three major steps: installing Madam, 
installing MySql, and tuning up the Madam and MySql.  What you need to do is to run 
the setup.bat file in the application folder. The entire process of installation may take 
20 minutes, depending on the CPU speed of your system.  Following steps will guide you 
to install the software.    

   
(1) Run 'setup.bat' to have an Installer Window. 

 

 
 

(2) Click Install All button to install both Madam and MySql.  If you have MySql 
previously installed on your system, you need to remove it before the installation. 
You can install either of the programs by clicking 'Install Madam' or 'Install MySql' 
respectively. 

(3) Follow the instructions of the installers to complete the installation of both 
programs.  It is strongly recommended to install the programs at the default 
directories (c:\program files\tigrmadam\ for Madam, and c:\mysql for MySql).  If 
you really want to install the programs at other directories, you must click the 
'Choose Folder" button and provide the locations for installations.  Please note that 
you MUST set the same locations when you have install windows again for 
installing Madam and MySql respectively. 

(4) After installations of Madam and MySql, you will have a configuration window.  Set 
the memory size for MySql to store data.  We recommend setting more than 1 GB. 
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(5) The default database name is 'mage'; and use-id and password are 'root'.  You can 
change them to yours (You can add more databases with Madam Administrator or 
Preference … in the program). Then, click 'OK' button. 

(6) It will take a couple of minutes to create databases and insert data to a testing 
database (test_mage).  The process of inserting data could be very slow at some 
point, so that the installer seems to be frozen. If the timer is counting, you should 
wait for a while. Please be patient. 

(7) Click Exit to close the Installer Window.  Now, it is ready to use Madam. 
 
 
2.  Uninstallation 

 
To uninstall Madam, from 'Start --> Programs --> TigrMadam', click 'Uninstall Tigr 
Madam'. To uninstall MySql, open 'Control Panel' from 'Start --> Setting'; click 
'Add/Remove Programs' and select 'MySql'.  If you cannot remove the entire 
programs, you might need to manually delete the mysql and tigrmadam folders under 
c:\ and c:\program files\ respectively (or at your selected locations). 
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1. Start the application 
 

From 'Start --> Programs --> TigrMadam', click Madam.  Alternatively, you can run 
the madam.bat under “..\tigrmadam\” folder to start the program. 

You will be asked to provide your user-id and password you set during the installation.  
Having provided the correct user-id and password, Madam will start MySql and be ready 
to use. 

2. Interface 
 

The interface of Madam could be categorized into four parts, as indicated in the picture 
2.1. The Tool Bar shows the database and page you are working on. Also the tool bar 
allows you to terminate the Madam or use other tools, such as Query Window, PCR 
Score, and others. On the left side of the page is a Navigation Panel that allows you 
to open pages in the Working Panel to process different jobs. The Working Panel on 
the right shows you the pages corresponding to the buttons on the Navigation Panel. 
The Log Panel is at the bottom that keeps a log of the operations performed and an 
Event Log window informs you about the events. 
 

 
 
Figure 2.1: The Interface of Madam 

 
2.1  Tool Bar 
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The Tool Bar contains four menus: File, Entry, Tools, and Help (see Figure 2.2). 
Clicking QUIT from the file menu terminates Madam. The Entry menu functions as 
the buttons in the Entry tab (see picture 2.1 above) and presents corresponding 
pages for data entry.  The Tools menu allows you to open Query Window (a 
friendly tool used to query the Database), PCR Score, Miner, Express 
Converter, and Experiment Designer. By clicking Help menu, you can get more 
information about how to use the program. 

 

Figure 2.2:  The tool bar 

 
2.2  Navigation Panel 
 

The Navigation Panel provides you with four tabs, Entry, Report, Application, 
and MAGE-ML (Figure 2.3), for job selections. Entry tab shows a set of buttons to 
trigger different pages for data entry. The buttons represent the data flow in the 
microarray research and you must follow the flow to enter data. Report tab 
presents a list of selections for Study, Experiment, Slide, Slide Type, and Probe. 
With the list, you can have a report about the selected items. MAGE-ML tab allows 
you to export the data in MAGE-ML format.  Application tab brings about buttons 
through which you can launch a program for data management. 
 

 
 

Figure 2.3: Navigation panel 
 
2.3   Working Panel 

 
The Working Panel shows you different pages based on the buttons you clicked in 
the Navigation Panel (Figure 2.4). All the pages have a Comment area and two 
buttons: Enter and Clear. You can write some comments for the pages you are 
working on. When all the entry fields have qualified data, the Enter button will be 
activated. Clicking Clear button will erase what you have typed in that entry. 
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Figure 2.4: Working panel showing entries of San. 
 

2.4   Log Panel 
 

The Log Panel contains an Event Log window that shows you messages about 
your operations (Figure 2.5). The messages are printed in three colors. Blue 
indicates that your job has been successfully completed; red indicates errors; and 
black suggests a general message. 

 

 
 

Figure 2.5: Log panel showing process messages. 
 
2.5   Data Validation 
 

Madam has a data auto-validation function for data entry. In the course of your 
data entry, once the field becomes red, it indicates that some errors had occurred. 
You can move the mouse over the color to see what the error is. If the red color is 
gone, it suggests that your entry was valid. Only when all entry fields have white 
colors, is the Enter button activated. Figure 2.6 shows the data in the field Sample 
Name is “required”. 

 



Interface                                                                                               7 

 

 
 

Figure 2.6: Red background suggests the errors. 
 

2.6   Smart List 
 

Madam is equipped with a feature called Smart List that allows you to search data 
quickly. If you click the arrow at the right of an entry field, a list of valid data will 
be shown. You can focus or shorten the list by typing the beginning of your entry. 
The top of the figure 2.7 shows a list of data for Sample Name and the bottom 
represents that when "Om" is typed, the list shows only data starting with "Om". 
 

 
 

Figure 2.7: The entry can shorten the list. 
 

2.7   Informative Label 
 

Informative Label is a tool to keep track of where the data are saved in the 
databases. If you move your mouse over a label of an entry field for 1-2 seconds, a 
small box will show you the table name and field name. For example, figure 2.8 
shows you that the Project Name in Slide Page will go to slide_name in the table 
Slide. 

 

 
 
Figure 2.8: The label can show where data are inserted. 
 

2.8   Confirmation Window 
 

The Confirmation Window or Confirmation Page allows you to check your data 
entry before you submit to the database. Other than a table that contains the 
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entry, there are a progress bar and three buttons (see Figure 2.9). If you find a 
mistake, you can close the window by click the Cancel button. Clicking the Submit 
button will start the process of updating the database. The progress bar shows you 
the percentage of the process that is done. You can print the data entry by clicking 
the Print button as you print a report (see section 4.7, Print a Report You Are 
Viewing). 
 

 
 

Figure 2.9: Confirmation Window shows what will be inserted. 
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3. Data Entry 
 

Madam is an interface for data entry. There are 8 pages for Study, Probe Source, 
Probe, Slide, Hybridization, Scan, Expression, and Analysis respectively. You can switch 
among them by clicking buttons in the Navigation Panel. The buttons are arranged in 
sequential order, so you should enter data in that order. In other words, only after you 
enter probe and slide information, can you enter hybridization data.  Entering data is 
straightforward, just following the instructions in each page. If you create a new 
database, the correct procedure for uploading data is: ] 
 
(1)  Enter an organism using New Organism Window. 
(2)  Enter an organism using New Organism Window. 
(3)  Upload your plate and PCR information with PCR Score. 
(4)  Insert study information with study page. 
(5)  Insert probe source data with Probe Source page. 
(6)  Use other pages ...  
 
3.1   Entering Study Information 

Study page collects sgeneral information about a research project. A study can 
have a set of experiments (hybridizations). 

(1)  Fill in New Study Name, Investigator, and Study Variables by typing or 
selecting from the list.  

(2)  Enter Factor and Values.  You can leave the Values and Unit blank, but you 
must enter the Factor.  Once the Factor is entered, the red square at the 
right up corner will change to gray, suggesting that you have entered 
qualified data. 

(3)  You can leave other entries blank. 
(4)  Type your comment in the Comment field if you want.  Right-clicking 

mouse will allow you to zoom in the Comment to have a large writing 
place. 

(5)  If Enter button is activated, click it to open Confirmation Page; 
otherwise, correct mistake to activate Enter button.  

(6)  Check if all entered data are correct. If they are, click Submit button on 
the Confirmation Page.  

 
3.2   Entering Probe Source Information 

 
(1) Fill in Sample Name, Tissue, Organism, and Provider fields by typing or 

selecting from the list.  
(2) You can leave other entries blank. 
(3) Select Source Nucleic Acid and Isolation Date. 
(4) Type your comment in the Comment field if you want. 
(5) If Enter button is activated, click it to open Confirmation Page; otherwise, 

correct mistake to activate Enter button.  
(6) Check if all entered data are correct. If they are, click Submit button on the 

Confirmation Page.  
 

3.3   Entering Probe Data 
 

Note: You must complete Probe Source entry before processing following steps.  
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(1) Fill in Probe Name, Sample Name, and Protocol Name by typing or selecting 
from the list.  

(2) You can leave other entries blank. 
(3) Select Dye Label and Nucleic Acid Produced, and Primer Type. 
(4) Type your comment in the Comment field if you want.  
(5) If Enter button is activated, click it to open Confirmation Page; otherwise, 

correct mistake to activate Enter button.  
(6) Check if all the entered data are correct. If they are, click Submit button on 

the Confirmation Page.  
 
3.4   Entering Slide Data 

 
The slide data involves slide name and slide type that describes how an array is 
designed. This makes the entering slide data a relatively complicated and resulted 
in three methods. 
 
3.4.1   Naming New Slide and Slide Type 
 

Note: To create a new slide type, you must uploaded plate information with 
PCR Score.  Also, you might need to complete Probe Source and Probe 
entries before processing following steps. 

(1) Click New tab under Slide Name. 
(2) Enter three letters as Project Name.  
(3) Select Glass Type and Number of Slide. 
(4) Fill in Surface Type, Surface Name, Attachment Method, and Protocol 

Name fields by type or selection from the list. 
(5) Click New tab under Slide Type. 
(6) Select a machine from Arrayer. 
(7) Fill in Type Name. 
(8) Select Number of Cols, Number of Rows, Columns of Pens, and 

Columns of Pens for array printing configuration if you select Generic 
for the Arrayer. Also select Pattern and Repeats on ... for Rows and 
Columns. It is recommended to select the same number for Number of 
Spots and Pattern. 

(9) Set Plate Order ... by using either Direct Set (see Creating Plate Order 
by Direct Setting) or Allies Set (see Create Plate Order by Alias 
Setting).  The plate order is the sequence of plates that are used to 
print a slide, consisting of a set of numbers, which represent the ids of 
plates and are created by Madam. 

(10) If Enter button is activated, click it to open Confirmation Page; 
otherwise, correct mistake to activate Enter button.  

(11) Check if all the entered data are correct. If they are, click Submit 
button on the Confirmation Page.  

3.4.1.1   Create Plate Order with Direct Setting 

Plate order is the consequence of plates that provide the samples 
for printing spots on a slide.  To set the order, you should have 
plate numbers (e.g. plate id) stored in the database with PCR 
Score. 
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(1) Click Direct Set tab under Plate Order. 
(2) Set Start number by clicking the arrow or direct type the 

number. 
(3) Use the same way to set End number. 
(4) Click Set button and the plate order will show in the field. You 

can edit the order by typing. Click Reset to erase plate order 
if you need to re-set.  

3.4.1.2   Create Plate Order with Alias Setting 

(1) Click Alias Set tab under Plate Order ...  
(2) Enter a few of starting letters for alias name to Alias field, and 

hit Return key. A list of alias name starting with what you 
typed will show under All Alias. If you type nothing, all aliases 
in the database will show. 

(3) Select those aliases you need to get their Plate Number. You 
can do multiple selections by holding Ctrl key during your 
selecting. 

(4) Move the selected alias name to Selected Alias by clicking the 
Right Arrow or double-clicking your selections. 

(5) Click Set button and the plate order will show in the field. You 
can edit the order by typing. Click Reset to erase plate order 
if you need to re-set.  

3.4.2   Naming New Slide with Existing Slide Type 

(1) Click New tab under Slide Name. 
(2) Enter three letters as Project Name. 
(3) Select Glass Type and Number of Slide 
(4) Fill in Surface Type, Surface Name, Attachment Method, and Protocol 

Name fields by type or selection from the list. 
(5) Click Select tab under Slide Type (Select is default when you select 

New for Slide Name). 
(6) Select a Slide Type from the list. 
(7) If Enter button is activated, click it to open Confirmation Page; 

otherwise, correct mistake to activate Enter button. 
(8) Check if all the entered data are correct. If they are, click Submit 

button on the Confirmation Page.  

3.4.3   Numbering Slides with Existing Name 

(1) Click Select tab under Slide Name. 
(2) Select a slide name from the list (Note: Madam will give your slide a 

new name based on your selection, but not use what you select as the 
name). 

(3) Select a number from Number of Slide. 
(4) If Enter button is activated, click it to open Confirmation Page; 

otherwise, correct mistake to activate Enter button. 
(5) Check if all the entered data are correct. If they are, click Submit 

button on the Confirmation Page.  

3.5   Entering Hybridization Data 
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Note: You must complete Probe Source, Probe, and Slide entries before entering 
hybridization information.  

(1) Fill in Study Name and Slide Name fields by typing or selecting from the list. 
(2) Fill in New Experiment Name field with whatever you want to name.  If you 

leave it blank, the slide name you selected will be used as the name.  
(3) Fill in Probe fields for Probe1 and Probe2. You can filter the probe names by 

selecting My Probes or All Probes. 
(4) Indicate which probe works as reference by clicking Reference under the 

probe name. 
(5) If there are experiment factors associated with probe, click the Expt. Factor 

button under the probe name and select them. 
(6) Fill in Protocol Name, Protocol, Block Agent, Wash Method, Instrument, 

Volume, Time, and Temperature fields. 
(7) Select or un-select Biological Replicates, PolyA, Low Complexity, and 

Unspecific Binding. 
(8) Type your comment in the Comment field if you want. 
(9) If Enter button is activated, click it to open Confirmation Page; otherwise, 

correct mistake to activate Enter button. 
(10) Check if all entered data are correct. If they are, click Submit button on the 

Confirmation Page.  

3.6   Entering Scan Data 
 

Note: You must complete Probe Source, Probe, Slide, and Hybridization entries 
before entering scan information.  

(1) Fill in Experiment Name field by typing or selecting from the list. 
(2) Select a scanner from Scanner list. If there is no scanner for your selection, 

you can add a scanner from Preference Window. 
(3) Fill in Power and PMT fields for Probe 1 and Probe 2. 
(4) Select Dye. 
(5) Fill in Original File Name 1, Original File Name 2, and Destination Location 

fields by typing the path and name directly or clicking the Browse button. 
(6) Type your comment in the Comment field if you want. 
(7) If Enter button is activated, click it to open Confirmation Page; otherwise, 

correct mistake to activate Enter button. 
(8) Check if all entered data are correct. If they are, click Submit button on the 

Confirmation Page.  

3.7   Entering Expression Data 
 

Note: You must complete Probe Source, Probe, Slide, Hybridization, and Scan 
entries before entering expression information.  

(1) Fill in Experiment Name field by typing or selecting from the list. 
(2) Select Reference Data Column. 7 and 8 refer the intensity columns in the 

TIGR-TAV/MEV files. 
(3) Fill in TAV/MEV File Name filed by typing the path and name directly or 

clicking the Browse button. 
(4) Type your comment in the Comment field if you want. 
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(5) If Enter button is activated, click it to open Confirmation Page; otherwise, 
correct mistake to activate Enter button. 

(6) Check if all entered data are correct. If they are, click Submit button on the 
Confirmation Page.  

 
3.8   Entering Analysis Data 
 

Note: You must complete Probe Source, Probe, Slide, Hybridization, Scan, and 
Expression entries before entering analysis information.  

(1) Fill in Experiment Name, File Name 1, Normalization 1, File Name 2, and 
Normalization 2 fields by typing or selecting from the list. 

(2) You can leave Program Name filed blank. 
(3) Type your comment in the Comment field if you want. 
(4) If Enter button is activated, click it to open Confirmation Page; otherwise, 

correct mistake to activate Enter button. 
(5) Check if all entered data are correct. If they are, click Submit button on the 

Confirmation Page.  

3.9   Entering New Organism Data 
 

When you click New Organism button in the Navigation Panel, a small window, 
New Organism window, will be presented (see Figure 3.1). This window allows you 
to search or submit an organism from or to database. 
 

 
 

Figure 3.1:  New organism window. 
 

3.9.1   Searching an Organism From Database 
 

Select an organism from the Organism Name list. You can find a name 
quickly by typing the starting letters and hit the Return key.   When you 
select an organism, the Organism DB, Plate Prefix, and Taxon ID fields will 
be filled with related information. If you want to erase what you have typed, 
click Clear button.  

 
3.9.2   Submitting an Organism to Database 
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(1) Fill in Organism Name field by typing or selecting the list. You can find 
a name quickly by typing the starting letters and hit the Return key. 
If you know the taxon id, you can fill in the Taxon ID filed and click 
Select button. Then, the organism will show in the Organism Name 
field. 

(2) Click Submit button.
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4. Data Report (Query) 
 

Madam is also an interface for data retrieval. You can view Study, Experiment, Slide, 
Slide Type, and Probe data by clicking the View buttons at the Report tab in the 
Navigation Panel (see Figure 4.1). Once you click the button, the reports will be 
presented on the Working Panel. The history of your viewing will show in a list under 
Recent Reports. You can view any history report by clicking it.  You can save or print the 
reports (see 4.6 and 4.7). 
 

 
 
Figure 4.1: The report panel 
 

4.1   Viewing Study Report 

(1) Click Report tab in the Navigation Panel. 
(2) Fill in Study field by typing or selecting from the list. 
(3) Click the View button. If there are data for the Study you entered or 

selected, the report will show in the Working Panel. 

4.2   Viewing Experiment Report 

(1) Click Report tab in the Navigation Panel. 
(2) Fill in Experiment field by typing or selecting from the list. 
(3) Click the View button. If there are data for the Experiment you entered or 

selected, the report will show in the Working Panel. 

4.3   Viewing Slide Report 
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(1) Click Report tab in the Navigation Panel. 
(2) Fill in Slide field by typing or selecting from the list. 
(3) Click the View button. If there is already data for the Slide you had entered 

or selected, the report will be displayed in the Working Panel.  

4.4   Viewing Slide Type Report 

(1) Click Report tab in the Navigation Panel. 
(2) Fill in Slide Type field by typing or selecting it from the list. 
(3) Click the View button. If there is already data for the Slide Type you had 

entered or selected, the report will be displayed in the Working Panel.  

4.5   Viewing Probe Report 

(1) Click Report tab in the Navigation Panel. 
(2) Fill in Probe field by typing or selecting from the list. 
(3) Click the View button. If there is already data for the Probe you had entered 

or selected, the report will be displayed in the Working Panel. 

4.6   Saving the Report You Are Viewing 

(1) Click Save button to open a file choose window (see Figure 4.2). 
(2) Set the file location (directory) by selecting from Look in and the folder in the 

window. 
(3) Fill in the File name field. 
(4) Click the Save button. The file will be saved as a HTML file so that you can 

open it with a web browser.  

 
 

Figure 4.2: The file chooser window allows you to save a file. 
 

4.7   Printing the Report You Are Viewing 
 

(1) Click Print button to open a Print window (see Figure 4.3). 
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(2) Select a printer from the Name in the Printer group. 
(3) Click the OK button. If you are not sure what you will print out, click Print 

Preview button to view the pages. You can click the Print button on the 
Report Preview window to print the report. 

 
 

Figure 4.3: Printer chooser window. 
 

4.8   Preview the Report to Be Printed 

(1) Click Print Preview button to open a Report Preview window (see Figure 
4.4) and what you will print out is showed in the window.  

(2) Click Next button to view the next page and click the Previous button to 
view the last page 

(3) Click the Print button to print out the report.  
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Figure 4.4: Preview window. 
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5. Applications 
 

Other than the interface for data management, Madam allows you to run many useful 
applications such as Experiment Designer, PCR Score, Miner, Query Window, and 
Express Converter by clicking the Experiment Designer, PCR Score, Miner, Query 
Window, and Express Converter buttons (see Figure 5.1). Also, you can launch them 
from the Tools menu. 
 

 
 

Figure 5.1: Navigation panel. 
 
5.1   Running Experiment Designer 
 

Experiment Designer is a tool that can facilitate your experiment design.  Using it, 
you can easily to draw a design graph and save the design as a file.  

(1) Click Application tab in the Navigation Panel; or click Tools at the tool bar.  
(2) Click Expt Designer button to launch the program.  You can get detailed 

information by clicking the Help button in the program. 

5.2   Running PCR Score 

(1) Click Application tab in the Navigation Panel; or click Tools at the tool bar. 
(2) Click PCR Score button to run the program.  You can have more information 

from PCR Score Manual. 

5.3   Running Miner 

Miner is a tool that allows you to retrieve the data from database for an 
experiment and save the data as a TIGR mev or tav file, so that the data can be 
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analyzed with MIDAS and MEV. Clicking the Miner button in the Application tab in 
the Navigation Panel or selecting Miner under Tools menu at the tool bar will 
present an interface (see Figure 5.2) in the Working Panel. Process following steps:  

 
 

Figure 5.2: Miner interface. 
 

(1) Select an experiment name from the Experiment Name list. 
(2) If you want to filter those spots with some degree of PCR qualities, check 

them under Amplified Value Filter.  The intensities of those spots will be set to 
zero.  Please refer to PCR Score manual for detailed information about the 
scores. 

(3) Checking the Add buffer box will keep the empty spots on the array in the 
mev/tav file. 

(4) Select the Output for the file type. 
(5) Provide a file name in the TAV File Name field.  You can click Browser button 

to find where you want to save on your system. 
(6) Click Retrieve button to start.  
(7) Clicking Reset button can erase what you have set.  
(8) You can stop the retrieving at any time by clicking the Cancel button. 

 
5.4   Running Query Window 
 

The Query Window provides you a tool to query databases with SQL 
programming. As the following pictures (Figure 5.3) shows, the window consists of 
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a Query and Results areas, plus several buttons. With the window, you can 
manipulate the data in database by SQL programming or SQL files. Also, you can 
save your SQL programs and the query results. 
 

 
 

Figure 5.3: Query window. 
 

5.4.1   Query Data by SQL Programming 

(1) Type SQL codes in the Query filed (you can enter multiple lines by 
typing the Return key). 

(2) Click Submit button; if no error occurs, the query results will show in 
the Results field.  

(3) Clicking Reset button can erase the Query filed;  

You can use the previous SQL codes by keeping clicking the "‹Query"; or 
"Query›" buttons.  Also, you can save your SQL codes and the query 
results as a file.  

5.4.2   Query Data by SQL File 

If you have saved your SQL codes as a file, you can query a database by 
following the steps.  

(1) Click the Load Query button to open a File Choose Windows. 
(2) Fill in the File Name by typing the path and name of the file or 

selecting from the Look in list and the window. 
(3) Click the Open button and the SQL codes will show in the Query filed. 
(4) Click Submit button and query results will be presented the Results 

field.  
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5.4.3   Saving SQL Codes as a File 

(1) Click the Save Query button to open a File Choose Window. 
(2) Fill in the File Name by typing the path and name of the file or selecting 

from the Look in list and the window;. 
(3) Click the Save button.  

5.4.4   Saving SQL Results as a File 

(1) Click the Save Results button to open a File Choose Window. 
(2) Fill in the File Name by typing the path and name of the file or selecting 

from the Look in list and the window. 
(3) Click the Save button.  

5.5   Running ExpressConverter 

ExpressConverter is a file format conversion tool that can change a variety of 
microarray data files to TIGR Mev/Tav files; as a result the data files are accessible 
by TIGR MIDAS and MEV. At time being, the ExpressConverter can take GenePix, 
ImaGene, and ScanArray files as inputs. 

(1) Click Application tab in the Navigation Panel; or click Tools at the tool bar. 
(2) Click Express Converter button to launch the program.  For detail 

information, please read the help manual by clicking the Help button in the 
ExpressConverter tool bars. 

 

Figure 5.4: ExpressConverter interface.
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6. MAGE-ML Writing 

After you upload your microarray data into the database, you can export them in MAGE-
ML format so that the data could be exchangeable among your colleagues or submitted 
to public database such as ArrayExpress. Clicking the MAGE-ML tab in the Navigation 
Panel will show a MAGE-ML tree; when a branch or a node of the tree, representing a 
MAGE-ML object, is clicked, an interface that is suitable to the object will be presented in 
the Work Panel showed in picture 6.1. 

 
 

Figure 6.1: The interface for writing MAGE-Ml files 

You can select one or multiple objects under the same branch to export MAGE-ML files. 
As soon as all the required fields contain qualified entries, the MAGE-ML button will be 
activated. Clicking it will start the writing.  

6.1   Write Array Out 

The Array branch deals with the information about how arrays are created and 
deviated, and grouped. You can write all nodes (objects) at the same time by 
clicking the Array or any of the objects separately by clicking it (i.e. ArrayDesign, 
ArrayManufacture, and so on). The general steps are;  
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(1) Select the MAGE-ML object by clicking it. You can select multiple objects by 
holding the [Ctr] key while selecting.  

(2) In the Work Panel, add person names to the Persons list and indicate who will 
be the submitter, researcher, supervisor, or curator. You can select the 
person by choosing the First Name, Last Name, Organization or others in the 
Person Information area, then select a Role for the person, and click the Add 
button. If you make a mistake for the setting, you can click Remove to drop 
the person from the list.  

(3) Select a slide name from the Slide Name list.  

(4) Provide a file name and path in the File Name field. You can click  icon to 
find the path on your system.  

(5) Click MAGE-ML button to start writing.  

6.2   Write AuditAndSecurity Out 

The AuditAndSecurity is used for tracking of changes and information on user 
permissions to view the data and annotation. It is written out with every object in 
the tree.  

(1) Select the AuditAndSecurity in the MAGE-ML pane.  
(2) In the Work Panel, add person names to the Persons list and indicate who will 

be the submitter, researcher, supervisor, or curator. You can select the 
person by choosing the First Name, Last Name, Organization or others in the 
Person Information area, then select a Role for the person, and click the Add 
button. If you make a mistake for the setting, you can click Remove to drop 
the person from the list.  

(3) The AuditAndSecurity should be associated with one of the MAGE-ML objects: 
Study Name, Experiment Name, or Slide Name. Select one of them by clicking 
the radio button before them.  

(4) Select appropriate name from the list you have selected in above step.  

(5) Provide a file name and path in the File Name field. You can click  icon to 
find the path on your system.  

(6) Click MAGE-ML button to start writing.  

6.3   Write BioMaterial Out 

The BioMaterial describes how a BioSource is treated for making an array and 
hybridization. 

(1) Select the BioMaterial in the MAGE-ML pane.  
(2) In the Work Panel, add person names to the Persons list and indicate who will 

be the submitter, researcher, supervisor, or curator. You can select the 
person by choosing the First Name, Last Name, Organization or others in the 
Person Information area, then select a Role for the person, and click the Add 
button. If you make a mistake for the setting, you can click Remove to drop 
the person from the list. s 

(3) Select a probe from the Probe Name from the list.  

(4) Provide a file name and path in the File Name field. You can click  icon to 
find the path on your system.  

(5) Click MAGE-ML button to start writing.  
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6.4   Write BioSequence Out 

The BioSequence describes a known gene or sequence in the BioMaterial.  

(1) Select the BioSequence in the MAGE-ML pane.  
(2) In the Work Panel, add person names to the Persons list and indicate who will 

be the submitter, researcher, supervisor, or curator. You can select the 
person by choosing the First Name, Last Name, Organization or others in the 
Person Information area, then select a Role for the person, and click the Add 
button. If you make a mistake for the setting, you can click Remove to drop 
the person from the list. Select a slide name from the Slide Name list.  

(3) Provide a file name and path in the File Name field. You can click  icon to 
find the path on your system.  

(4) Click MAGE-ML button to start writing. 

6.5   Write Experiment Out 

The Experiment represents the container for a hierarchical grouping of BioAssays. 
It can have the end results of Clustering Analysis specified and, through the 
ExperimentDesign, a description and annotation of the overall design of the 
experiment and what it was to show. You can write all nodes (objects) at the same 
time by clicking the Experiment or any of the objects separately by clicking it (i.e. 
BioAssay, BioAssayData, and so on). The general steps are;  

(1) Select the MAGE-ML object by clicking it. You can select multiple objects by 
holding the [Ctr] key while selecting.  

(2) In the Work Panel, add person names to the Persons list and indicate who will 
be the submitter, researcher, supervisor, or curator. You can select the 
person by choosing the First Name, Last Name, Organization or others in the 
Person Information area, then select a Role for the person, and click the Add 
button. If you make a mistake for the setting, you can click Remove to drop 
the person from the list.  

(3) If you want to write out all experiments (hybridizations) at the same time, 
click Study tab and select a study name from the drop-down list.  

(4) If you want to write some experiments of a study, click the Experiment tab, 
select a study name, and press RETURN key. The all experiments of the 
study will show on the left list. Select those you want and click the arrow 
button to move them to the right list. Double-clicking the selected 
experiments will move them between the left and right lists. You can save the 
selected experiment into a file by clicking Save button; and later you can load 
the file by clicking Import button.  

(5) Select the Internal or External for your BioAssayData (expressions) output 
type. The internal suggests that the data are embraced into the MAGE-ML 
file; and external means the data are saved as other files that can be 
referenced by the MAGE-ML file.  

(6) Provide a file name and path in the File Name field. You can click  icon to 
find the path on your system.  

(7) Click MAGE-ML button to start writing.  

6.6   Write Protocol Out 
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The Protocol describes a generic laboratory procedure or analysis algorithm. 

(1) Select the Protocol in the MAGE-ML pane.  
(2) In the Work Panel, add person names to the Persons list and indicate who will 

be the submitter, researcher, supervisor, or curator. You can select the 
person by choosing the First Name, Last Name, Organization or others in the 
Person Information area, then select a Role for the person, and click the Add 
button. If you make a mistake for the setting, you can click Remove to drop 
the person from the list.  

(3) Select a protocol name from the Protocol Name list.  

(4) Provide a file name and path in the File Name field. You can click  icon to 
find the path on your system.  

(5) Click MAGE-ML button to start writing.s
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7. Configuration 

Madam can be customized to meet your requirements by Administrator or Preference 
Window. For example, you can create a new database, change name of a scanner, add 
researcher or organization information for writing MAGE-ML, and even alter JDBC 
settings for other DBMS (i.e. Sybase/Oracle).  

To launch the Administrator, click Start --> All Programs --> TigrMadam --> 
Administrator. If have your current Madam updated, you need to go to “..\TigrMadam\” 
folder to execute MadamAdministratorW.exe file by double-clicking it.  

 
 

Figure 7.1:  Configuration window. 
 

7.1   Create New Databases 
 

Note: Creation of databases is functional only on MySql DBMS installed on your 
local machine.  

 
You can create a new database that has the identical schema as test_mage by 
using Madam Administrator or Preference Window. To open the Preference 
Window, click Preference ... under the File menu.  

(1) Open Preference Window or launch Madam Administrator.  
(2) Click Database tab.  
(3) Click local node or any database name.  
(4) Click Add button to open an input dialog.  
(5) Type a database name and click OK button to close the dialog; the new 

database will show under local node.  
(6) Click the OK button to close the Preference Window (You can click Apply 

button in the Administrator without closing the window). At the same time, 
a process dialog will show up. When the dialog close, the database is created. 

7.2   Delete Databases 

Note: You can only delete the name of database in the list without affecting the 
database. To remove the database, you must use MySql commands.  
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(1) Open Preference Window or Madam Administrator.  
(2) Click Databases tab.  
(3) Select a database name you want to delete.  
(4) Click Remove button.  
(5) Click the OK button to close the Preference Window (You can click Apply 

button in the Administrator without closing the window).  

7.3   Change Database Name 

Note: You can only change the name of database in the list to match the name on 
DBMS. To make really change, you have to use MySql commands.  

(1) Open Preference Window or Madam Administrator.  
(2) Select a database name you want to change.  
(3) Click Edit button to open an input dialog.  
(4) Type new database name and click OK button to close the dialog; the new 

database name will show under local node.  
(5) Click the OK button to close the Preference Window (You can click Apply 

button in the Administrator without closing the window).  

7.4    Modify JDBC Settings 

If your databases are set on other DBMS (i.e. Sybase/Oracle), you can change the 
JDBC parameters to make Madam accessible to the DBMS.  

(1) Open Preference Window or Madam Administrator.  
(2) Click JDBC tab.  
(3) Select a DBMS name from the Database Management System list. When 

selected, the corresponding JDBC Driver will show.  
(4) Click the OK button to close the Preference Window (You can click Apply 

button in the Administrator without closing the window).  

If there is no suitable DBMS name, click the Add button to open a New JDBC 
Window to add. You can get more information by clicking the Help button in the 
New JDBC Window.  

If the DBMS name or JDBC Driver string is not correct, click the Edit button to open 
a New JDBC Window to change. You can get more information by clicking the 
Help button in the New JDBC Window.  

Clicking Remove button will delete the selected DBMS and JDBC driver from the 
list.  

7.5    Change Scanner Names 
 

When entering data with Scan page, you need to select a scanner. If there is no 
your scanner, you can change the name of (or add) a scanner.  

(1) Open Preference Window or Madam Administrator.  
(2) Click Scanner tab.  
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(3) Click Edit button to open an input dialog. If you want to add a scanner, click 
Add button.  

(4) Type new scanner name and click OK button to close the dialog; the new 
scanner name will show in the Scanner list.  

(5) Click the OK button to close the Preference Window (You can click Apply 
button in the Administrator without closing the window).  

7.6   Manage Person Information 

Person information required to export MAGE-ML refers to the names and contact 
information of researchers and code makers. You can set them with 
Administrator or Preference Window. Both have the same interface as 
following (Figure 7.2).  

It is straightforward to see that the Add, Edit, and Remove buttons allow you to 
add, change, and delete the person information from the lists.  

 
 

Figure 7.2: Person information window. 
 

7.7   Manage Organization Information 

The information about your organization is required to export MAGE-ML files, 
especially its URL on internet. You can set the Organization with Administrator or 
Preference Window. Both have the same interface as following (Picture 7.3) 

As managing person information, the tree buttons, (Add, Edit, and Remove), allow 
you to add, change, and delete the organization information from the lists.  
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Figure 7.3: Organization window 
 

7.8   Set User-Id and Passwords 

If you have difficulty to login the databases, it might need to set user-id and 
password again.  

(1) Run Madam Administrator.  
(2) Click Login tab.  
(3) Fill in the User ID and Password fields.  
(4) Click the OK button to close the Administrator (You can click Apply button in the 

Administrator without closing the window).  
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8. Troubleshooting 
 

8.1   I cannot start Madam Installer.   
 

ERROR:  When I double-click the 'setup.bat' from the CD, a black window opened 
and closed. 

ANSWER: You need to install Java Running Environment (JRE) on your system.  
Open the folder 'jvsuport' and double click 'jre-1_3_1_02-win.exe'. 
Follow the instructions to install the JRE. 

 
8.2   I cannot change the reserved memory for MySql DBMS. 
 

ERROR:  I removed MySql with 'Add/Remove Program' from 'control panel'. When 
I reinstalled MySql and wanted to change the reserved memory, I failed 
to do that. 

ANSWER: You might need to manually delete 'mysql' folder and its content before 
you re-install the MySql.  If you cannot delete the 'mysql' folder, it might 
result from the running of Mysql.  Refer to the next question to stop 
MySql. 

 
8.3   I cannot re-install MySql 
 

ERROR:  I failed to install TIGR Madam and MySql at a time. When I re-install the 
programs, I always get failed. 

ANSWER: The MySql might be running and keep you from starting it again.  You 
need to shutdown or kill MySql by following steps: 

            
(1) Open 'Window Task Manager' by right clicking the window menu bar and 

select 'Task Manager'.  You can open it by pressing 'Ctrl', 'Alt', and 'Delete' 
keys simultaneously, and click 'Task Manager' button (for Window2000). 

(2) Click 'Processes' tab and select 'mysql-max.exe' under the 'image name'. 
(3) Right click mouse button and select 'End Process'. 
(4) Click 'OK' button to kill MySql (It will take about 10 seconds to completely 

stop MySql). 
 

8.4   I cannot login the database 
 
ERROR:  When I run Madam and tried to login a database, I got 'Unable to 

connect to server' error message. 
ANSWER: There could be two causes: 
 

Did you type right user-id and password?  
(Please note, user-id and password are case sensitive). 
  
Do you have the database in MySql?  

            
Following steps help you to check the database. 

                   
(1) Leave the error message showing.  This will allow MySql to keep running. 
(2) Open a DOS window and change the directory to 'c:\mysql\bin' by typing 'cd 

mysql\bin'. 
(3) Type 'mysql' and hit 'Return'. 
(4) Type 'show databases;' 
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If the database you want to login is not in the list, you need to add the database to 
MySql. 


